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Creating a Presentation 

Office PowerPoint 2010  
Lab 1 
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1. Use a template to create a presentation 
2. View and edit a presentation 
3. Copy and move selections 
4. Move, copy, and delete slides 
5. Move, demote, and promote items 
6. Use a numbered list 
7. Check spelling 

 

Objectives 

Presenter
Presentation Notes
Use a template to create a presentation
View and edit a presentation
Copy and move selections
Move, copy, and delete slides
Move, demote, and promote items
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8. Size and move placeholders 
9. Change fonts and formatting 
10. Insert and modify clip art 
11. Run a slide show 
12. Document a file 
13. Preview and print a presentation 

Objectives 

Presenter
Presentation Notes
Insert and modify clip art
Run a slide show
Document a file
Preview and print a presentation
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Concept Preview 

1. Slide 
2. Spelling Checker 
3. AutoCorrect 
4. Layout 
5. Graphics 

 

Presenter
Presentation Notes
Slide - An individual “page” of your presentation
Spelling Checker – Locates misspelled words, duplicate words, and capitalization irregularities, and proposes possible corrections
AutoCorrect - Automatically corrects an entry based on basic assumptions about the text
Layout - Layouts control the placement of objects on a slide
Graphics – An object such as a drawing or picture that can be added to a slide
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Outline 

• Starting a New Presentation 
– Developing a Presentation 
– Exploring the PowerPoint Document Window 
– Entering and Editing Text 
– Inserting a Slide 
– Opening a Presentation Template 
– Moving Among Slides 

• Editing a Presentation 
– Using the Outline Tab 
– Correcting Errors 
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Outline 

• Editing a Presentation (cont.) 
– Copying and Moving Selections 
– Moving, Copying, and Deleting Slides 
– Moving, Demoting, and Promoting Bulleted Items 
– Splitting Text Between Slides 
– Creating a Numbered List 
– Moving, Demoting, and Promoting Numbered Items 
– Saving a Presentation 
– Opening an Existing Presentation 

• Using Spelling Checker 
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Outline 
• Using Slide Sorter View 

– Selecting and Deleting Slides 
– Moving Slides 
– Selecting a Slide Layout 
– Changing a Placeholder 
– Sizing a Placeholder 
– Moving a Placeholder 
– Adding and Removing Bullets 

• Formatting Slide Text 
– Changing Fonts 
– Changing Font Size 
– Applying Text Effects 
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Outline 

• Working with Graphics 
– Inserting a Graphic from the Clip Organizer 
– Sizing and Moving a Graphic 
– Adding Graphic Effects 

• Rehearsing a Presentation 
– Using Slide Show View 

• Documenting a File 
• Previewing and Printing the Presentation 

– Printing a Slide 
– Printing Handouts 
– Printing an Outline 



McGraw-Hill Copyright © 2011 by The McGraw-Hill Companies, Inc. All rights reserved.  

1-9 

Outline 

• Exiting PowerPoint 
• Summary 

– Key Terms 
– FAQs 
– Discussion Questions 
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• Developing a Presentation 
• Exploring the PowerPoint 

Document Window 
• Entering and Editing Text 
• Inserting a Slide 
• Opening a Presentation 

Template 
• Moving Among Slides 

STARTING A NEW 
PRESENTATION 
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Step Description 
Plan The first step in planning a presentation is to understand its purpose. You also need to find out the 

length of time you have to speak, who the audience is, what type of room you will be in, and what 
kind of audiovisual equipment is available. These factors help to determine the type of presentation 
you will create. 

Create To begin creating your presentation, develop the content by typing your thoughts or notes into an 
outline. Each main idea in your presentation should have a supporting slide with a title and bulleted 
points. 

Edit While typing, you will probably make typing and spelling errors that need to be corrected. This is one 
type of editing. Another type is to revise the content of what you have entered to make it clearer, or to 
add or delete information. To do this, you might insert a slide, add or delete bulleted items, or move 
text to another location. 

Enhance You want to develop a presentation that grabs and holds the audience’s attention. Choose a design 
that gives your presentation some dazzle. Wherever possible, add graphics to replace or enhance 
text. Add effects that control how a slide appears and disappears and that reveal text in a bulleted list 
one bullet at a time. 

Rehearse Finally, you should rehearse the delivery of your presentation. For a professional presentation, your 
delivery should be as polished as your materials. Use the same equipment that you will use when you 
give the presentation. Practice advancing from slide to slide and then back in case someone asks a 
question. If you have a mouse available, practice pointing or drawing on the slide to call attention to 
key points. 

Developing a Presentation 

Presenter
Presentation Notes
As you prepare to create a new presentation, you should follow several basic steps: plan, create, edit, enhance, and rehearse.

After rehearsing your presentation, you may find that you want to go back to the editing phase. You may change text, move bullets, or insert a new slide. Periodically, as you make changes, rehearse the presentation again to see how the changes affect your presentation. By the day of the presentation, you will be confident about your message and at ease with the materials.
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Slides tab 
displays slide 

thumbnails 

Selected slide 
displayed in slide 

pane 

Status 
bar 

Slide 
indicator 

View buttons 

Blank presentation 
file consisting of 

single slide open in 
Normal view 

Notes pane 

Exploring the  
PowerPoint Document Window 

Presenter
Presentation Notes
When you first start PowerPoint, a new blank presentation file, named Presentation1, is opened and displayed in the document window. It is like a blank piece of paper that already has many predefined settings. These default settings are generally the most commonly used settings and are stored in the Blank Presentation template file.

The Blank Presentation template consists of a single slide that is displayed in the document window.
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Concept    :  Slide 
• A slide is an individual 

page of your presentation 
• First slide of presentation is 

the title slide 
• Additional slides are used 

to support main points 
• Slides help to organize the 

presentation 

1 

Presenter
Presentation Notes
Slides:
Give the audience a visual summary
Helps to make the content easier to present 
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Viewing the Presentation 
View Button Description 
Normal Provides four working areas of the window 

that allow you to work on all aspects of your 
presentation in one place. 

Slide Sorter Displays a miniature of each slide to make it 
easy to reorder slides, add special effects 
such as transition, and set timing between 
slides. 

Reading  Displays each slide in final form within the 
PowerPoint window so you can see how it 
will look during a presentation but till have 
access to the Windows desktop. 

Slide Show Displays each slide in final form using the 
full screen space so you can practice or 
present the presentation. 

Presenter
Presentation Notes
When you first start PowerPoint, it opens in a view called Normal view. A view is a way of looking at a presentation and provides the means to interact with the presentation. PowerPoint provides several views you can use to look at and modify your presentation. Depending on what you are doing, one view may be preferable to another.
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Normal View 
Normal view with Slides tab selected 

Normal view with Outline tab selected 

Notes pane 

Slide pane 

Presenter
Presentation Notes
Normal view is displayed by default because it is the main view you use while creating a presentation. Normal view has four working areas: Outline tab, Slides tab, Slide pane, and Notes pane. These areas allow you to work on all components of your presentation in one convenient location.

The Outline tab displays the text content of each slide in outline format, and the Slides tab displays a miniature version or thumbnail of each slide. You can switch between the Slides and Outline tabs by clicking on the tab.

The Slide pane displays the selected slide. The Notes pane includes space for you to enter notes that apply to the current slide.
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Entering and Editing Text 

Placeholder selected and 
ready for entry of text 

Placeholders 

Placeholder text 

Presenter
Presentation Notes
Notice the slide contains two boxes with dotted borders. These boxes, called placeholders, are used to contain content such as text, graphics and other objects. In this case, the placeholders are text placeholders that are designed to contain text and display standard placeholder text messages that prompt the user to enter a title and subtitle.

As soon as you click on the placeholder, the placeholder text will disappear and will be replaced by the text you want to appear in the slide.
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Inserting a Slide 

New slide thumbnail is 
highlighted, indicating it is 

the current slide 

Title placeholder 

Inserts a new 
blank slide 

Content 
placeholder 

Presenter
Presentation Notes
Click the New Slide button in the Slides group to insert a new slide.
You also can use the keyboard shortcut Ctrl+M to insert a new slide.
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Opening a  
Presentation Template 

Preview area 
displays first page 

of selected 
template 

Blank presentation 
selected 

Template categories provide 
access to presentation 

template file on the 
Office.com Web site 

Presenter
Presentation Notes
PowerPoint ships with many supplied design templates. Several more are available online at the Office.com Web site.

The Available Templates and Themes window of Backstage view is open. The upper section of this window displays six options from which you can choose to start a new presentation from files that are stored on your computer. 

The Blank presentation template is selected, as this is the default template that is opened when you first start PowerPoint. 

The five other choices provide the means of starting a presentation from recent templates you have opened, templates you have created, or other existing presentations.
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Opening a Presentation  
Template from Office.com 

Preview of 
selected template 

Selected 
presentation 

Thumbnails represent 
available templates 

Presenter
Presentation Notes
When you choose a category of online templates, folders of additional subcategories are displayed that contain the available presentation template files. 

Thumbnail images representing the first slide in each template file are displayed in alphabetical order by name. The preview area displays a larger image of the selected thumbnail and information about the template.
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Moving Among Slides 

Scroll box 
ScreenTip 

Presenter
Presentation Notes
There are many ways to move from slide to slide in PowerPoint.
The quickest method is often to click on the slide thumbnail in the Slides tab.
Clicking on a slide in the Slides tab displays it in the Slide pane and makes it the current slide. However, if your hands are already on the keyboard, you may want to use the keyboard directional keys.
The table shows both keyboard and mouse methods to move among slides in Normal view.
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• Using the Outline Tab 
• Correcting Errors 
• Copying and Moving Selections 
• Moving, Copying, and Deleting 

Slides 
• Moving, Demoting, and 

Promoting Bulleted Items 
• Splitting Text Between Slides 
• Creating a Numbered List 
• Moving, Demoting, and 

Promoting Numbered Items 
• Saving a Presentation 
• Opening an Existing 

Presentation 

EDITING A PRESENTATION 
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Using the Outline Tab 
Click tab to open it 

Sample text deleted and 
placeholder text displayed 

Presenter
Presentation Notes
The Outline tab displays the content of the presentation in outline form, making it easy to see the organization of your presentation as you enter and edit content.

Click the Outline tab to open it.
Scroll the Outline tab to the top to display the text for slide 1.
Click anywhere on the text for slide 1 in the Outline tab to make it the current   slide.
Select the text.
Press DELETE.

As soon as you press a key, the selected text is deleted and replaced with the text you typed.

In the Outline tab, you can select an entire paragraph and all subparagraphs by pointing to the left of the line and clicking when the mouse pointer is a double-cross.
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Concept    :  Spelling Checker 
• Identifies errors as you 

type by underlining it 
with a wavy red line 

• Finds: 
– Misspelled words 
– Duplicate words 
– Capitalization 

irregularities 

• Suggests possible 
corrections 

2 

Presenter
Presentation Notes
Spelling checker feature advises you of misspelled words as you create and edit a presentation, and proposes possible corrections
Compares the word you type to a main dictionary of words supplied with the program
Checks the custom dictionary, a dictionary that you can create to hold words you commonly use but that are not included in the main dictionary
If the word does not appear in either dictionary, the program identifies it as misspelled by displaying a red wavy line below the word
You can then correct the misspelled word by editing it
Alternatively, you can display a list of suggested spelling corrections for that word and select the correct spelling from the list to replace the misspelled word in the presentation
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Correcting Errors  

Indicates document 
contains a spelling error 

Spelling error identified 
with a wavy red line 

Spelling corrections 
displayed in a 
shortcut menu 

Presenter
Presentation Notes
Like other Office 2010 applications, PowerPoint identified the word as misspelled by underlining it with a wavy red line.

A Spelling Indicator appears in the status bar.

Right-click on the misspelled word in the Outline tab to display the shortcut menu.

The menu also includes several related menu options described below.

Option 	Effect
Ignore All 	Instructs PowerPoint to ignore the misspelling of this 	throughout the rest of this session.
Add to Dictionary 	Adds the word to the custom dictionary list. When a 	word is added to the custom dictionary, PowerPoint will 	always accept that spelling as correct.
Spelling 	Opens the Spelling dialog box to check the entire 		presentation.

Sometimes the spelling checker cannot suggest replacements because it cannot
locate any words in its dictionary that are similar in spelling. Other times the
suggestions offered are not correct. If either situation happens, you must edit
the word manually. 
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Concept    :  AutoCorrect 
• A feature that makes assumptions 

about the text you are typing 
• Automatically corrects the entry 

– Inserts proper capitalization at the 
beginning of sentences 

– Capitalizes the days of the week 

• Looks for certain types of errors 
• Checks entries against a built-in 

list of commonly misspelled 

Additional Information 
Bulleted items in a 
presentation are 
capitalized in sentence 
case format. 
Ending periods, 
however, are not 
included. 

Bulleted items in a 
presentation are 
capitalized in sentence 
case format. Ending 
periods, however, are 
not included.         
                 

3 

Presenter
Presentation Notes
The AutoCorrect feature automatically corrects entries based on some basic assumptions about the text you are typing. The AutoCorrect feature automatically:
Inserts proper capitalization at the beginning of sentences and in the names of days of the week.
Change to lowercase letters any words that were incorrectly capitalized due to the accidental use of the l key. 
Corrects many common typing and spelling errors automatically.
Looks for certain types of errors, such as two capital letters at the beginning of a word.
Capitalizes lowercase letters appears at the beginning of a sentence.
Replaces a misspelled word with the correct spelling in situations where the spelling checker offers only one suggested spelling correction. 
Checks a built-in list of words that are commonly spelled or typed incorrectly and makes corrections based on that.
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Copying &  
Moving Selections 

New bulleted line 
created in Outline tab 

Presenter
Presentation Notes
A new bulleted line is automatically created whenever you press enter at the end of a bulleted item.

In the Outline tab, you can select an entire paragraph and all subparagraphs by pointing to the left of the line and clicking when the mouse pointer is a double-cross.

You also can press ctrl + C to copy a selection and ctrl + V to paste a selection.

You can copy and paste bullet text to create new bullets.
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Moving, Copying 
& Deleting Slides 

Use the options on 
the selected slide’s 

context menu. 

Use the drop-down 
menu in the Slides 

group. 

Presenter
Presentation Notes
Because you are not working with slide content, you will use the Slides tab to move, copy and delete slides.

Another Method: You can also choose Delete Slide from a selected slide’s context menu.

You can also delete and move slides in the Outline tab by clicking on the slide icon next to the slide number to select the entire slide and then use the appropriate command.
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Moving, Demoting,  
& Promoting Bulleted Items 

• Demoting a bulleted item 
– Moves it to the right 
– Makes it a lower or 

subordinate topic 

• Promoting a line 
– Moves it to the left, or 
– Moves it up a level  

Presenter
Presentation Notes
To Move: Select all the text in the item and drag the selection to a new location.

Can promote or demote bulleted items only after the text has been entered. 

The insertion point can be anywhere on the line to be promoted or demoted.
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Splitting Text between Slides 

AutoFit button 

Presenter
Presentation Notes
When the slide’s text exceeds the size of the placeholder, an AutoFit Options button appears at the bottom left corner of the placeholder. 

Two options allow you to handle any over-spilling text and both automatically adjust line spacing and text size.

The AutoFit feature will automatically adjust the line spacing and text size as needed to display the content inside the placeholder appropriately
The Split Text Between Two Slides option will automatically create a new slide with the same title and split the content between the two slides.
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Creating a Numbered List 
Converts selection 
to a numbered list 

Solid line border indicates 
entire placeholder will be 
affected by your actions 

Presenter
Presentation Notes
Open the Slides tab and click anywhere in the bulleted items the placeholder.
Click on the dashed line border of the placeholder box to change it to a solid line.
Click Numbering in the Paragraph group on the Home tab.
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Moving, Demoting,  
& Promoting Numbered Items 

New demoted 
numbered list item 

Presenter
Presentation Notes
To Move: Select all the text in the item and drag the selection to a new location.

You can promote or demote bulleted items only after the text has been entered. 

Demoting a bulleted item
Moves it to the right
Makes it a lower or subordinate topic
Promoting a line
Moves it to the left, or
Moves it up a level 

The insertion point can be anywhere on the line to be promoted or demoted.
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Saving the Presentation 

Specifies type of 
file to save as 

File list 

• Open the File tab 
and choose Open. 

• If necessary, 
select the location 
containing your 
data files. 

• Select the file you 
wish to open. 

• Click Open. 

To Open an Existing 
Presentation: 

New file name 

Specifies type of 
file to save as 

Address bar displays 
current location 

File list 

Presenter
Presentation Notes
Saving the Presentation

The Save or Save As commands on the File menu are used to save files
The Save command or the Save button will save the active file using the same file name by replacing the contents of the existing file with the document as it appears on your screen
The Save As command allows you to save a file with a new file name and/or to a new location
This leaves the original file unchanged
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USING SPELLING CHECKER 

Misspelled 
word identified 

Starts spelling 
checker 

Change To text 
box 

Suggestions list 
box 

Presenter
Presentation Notes
To correct the misspelled words, you can use the shortcut menu to correct each individual word or error, as you learned earlier or wait until you are finished writing and then: 
• Open the Review tab.
• Click Spelling in the Proofing group.

The Spelling dialog box displays the misspelled word in the Not in Dictionary text box. The Suggestions list box typically displays the words the spelling checker has located in the dictionary that most closely match the misspelled word. You can edit the word yourself by typing the correction in the Change To text box.
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• Selecting and Deleting 
Slides 

• Moving Slides 
• Selecting a Slide Layout 
• Changing a Placeholder 
• Sizing a Placeholder 
• Moving a Placeholder 
• Adding and Removing 

Bullets 

USING SLIDE SORTER VIEW 

 

Presenter
Presentation Notes
To get a better overall picture of the presentation, you will switch to Slide Sorter view. This view displays thumbnail images of each slide in the work area and is particularly useful for rearranging slides to improve the flow and organization of the presentation. Clicking on a thumbnail selects the slide and makes it the current slide.
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Selecting & Deleting Slides 

Indicator line 

Selected slide 

• Select the slide. 
• Drag it to its new 

location.  
• Drop it when the 

indicator line is 
located where 
you want the 
slide to be 
placed. 

To Move Slides: 

Presenter
Presentation Notes
Click to select a slide. Hold Ctrl and click to select more than one slide. A yellow border surrounds selected slides.

Use the drag and drop method to move slides.

To delete a slide:
Select the slide and press Delete.
Select the slide and choose Delete Slide from the slide’s context menu.



McGraw-Hill Copyright © 2011 by The McGraw-Hill Companies, Inc. All rights reserved.  

1-36 

Concept    :  Layout 4 

Presenter
Presentation Notes
Layouts define the position and format for objects and text that will be added to a slide. Layouts provide placeholders for slide titles and slide content such as text, tables, diagrams, charts, or clip art. Many of these placeholders are shown in the diagram.

You also can rearrange, size, and format placeholders on a slide any way you like to customize the slide’s appearance.

To make creating slides easy, use the predefined layouts. The layouts help you keep your presentation format consistent and, therefore, more professional.
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Selecting a Slide Layout 

Select the slide layout that 
best fits your content. 

Presenter
Presentation Notes
Though this image shows 9 built-in layouts, the number of available layouts varies with the template you are using.

• Open the Home tab.
• Open the Layout drop-down menu (in the Slides group).

If the new layout does not include placeholders for objects that are already on your slide (for example, if you created a chart and the new layout does not include a chart placeholder), you do not lose the information. All objects remain on the slide, and the selected layout is automatically adjusted by adding the appropriate type of placeholder for the object. Alternatively, as you add new objects to a slide, the layout automatically adjusts by adding the appropriate type of placeholder.
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Changing a Placeholder 

Dragging sizing handles 
adjusts the size of the 

placeholder 

Right placeholder 
adjusted to fit each 

bullet on a single line 

Left placeholder 
adjusted to fit content 

An object can be 
moved anywhere on a 
slide by dragging the 
placeholder’s border 
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Adding & Removing Bullets 
Converts selection 
to a numbered list 

Bullets added to 
selected items Bullets removed 

from selected items 

Presenter
Presentation Notes
You can quickly apply and remove bullets using Bullets in the Paragraph group on the Home tab. This button applies the bullet style associated with the design template you are using.

If the placeholder items already include bullets, using this button will remove them. If the bullets are removed, using this button will add them.
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• Changing Fonts 
• Changing Font Size 
• Applying Text Effects 

FORMATTING SLIDE TEXT 

 

Presenter
Presentation Notes
Applying different formatting to characters and paragraphs can greatly
enhance the appearance of the slide. 

Character formatting features affect the selected characters only. They include changing the character style and size, applying effects such as bold and italics, changing the character spacing, and adding animated text effects. 
Paragraph formatting features affect an entire paragraph. A paragraph is text that has an Enter at the end of it. Each item in a bulleted list, title, and subtitle is a paragraph. Paragraph formatting features include the position of the paragraph or its alignment between the margins, paragraph indentation, spacing above and below a paragraph, and line spacing within a paragraph.
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Changing Fonts 

Font used for 
selected text 

Live Preview shows 
how the formatting will 

affect selected text 

Font size used for 
selected text 

Presenter
Presentation Notes
Using fonts as a design element can add interest to your presentation and give
your audience visual cues to help them find information quickly. 

It is good practice to use only two or three different fonts in a presentation.

There are two basic types of fonts: serif and sans serif.
Serif fonts have a flair at the base of each letter that visually leads the reader to the next letter. Two common serif fonts are Roman and Times New Roman. Serif fonts generally are used for text in paragraphs. 
Sans serif fonts do not have a flair at the base of each letter. Arial and Helvetica are two common sans serif fonts. Because sans serif fonts have a clean look, they are often used for headings in documents.
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Applying Text Effects 

Italicized text 

Applies text effects 

Bold applied 
to subtitle 

Font Color button 

Color and Shadow 
effects applied to title 

Presenter
Presentation Notes
Further enhance the title slide by adding text effects such as color and shadow to the title and subtitle. The table describes some of the effects and their uses. The Home tab and the Mini toolbar contain buttons for many of the formatting effects.
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• Inserting a 
Graphic from 
the Clip 
Organizer 

• Sizing and 
Moving a 
Graphic 

• Adding Graphic 
Effects 

WORKING WITH GRAPHICS 
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Concept    :  Graphics 

Help the audience understand 
concepts, to add interest, and to 
make your presentation stand 
out 

Photograph 
Graphic Illustration 

Drawing Object 

5 

Presenter
Presentation Notes
A graphic is a non-text element or object, such as a drawing or picture, that can be added to a slide. 

A graphic can be a simple drawing object consisting of shapes such as lines and boxes. A drawing object is part of your presentation document. 
A picture is an image such as a graphic illustration or a scanned photograph. Pictures are graphics that were created from another program and are inserted in a slide as embedded objects. 
An embedded object becomes part of the presentation file and can be opened and edited using the source program, the program in which it was created.
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Inserting a Graphic 
from the Clip Organizer 

Selected clip art 

Large image of 
selected clip art 

Thumbnail images 
of located clips 

Enter descriptive 
text in Search For 

text box 

Presenter
Presentation Notes
Use the search facility to search for a topic or for a special type of graphic object. 

Clip Organizer is a Microsoft Office tool that arranges and catalogs clip art and other media files stored on the computer’s hard disk. The Clip Organizer’s files, or clips, include art, sound, animation, and movies you can add to a presentation. Additionally, if you are connected to the Internet, Microsoft’s Office.com Web site is automatically accessed for even more graphics.

The Preview/Properties dialog box displays the selected graphic in a larger size so it is easier to see. It also displays more information about the properties associated with the graphic. Notice the search word you entered appears as one of the keywords.
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Sizing & Moving a Graphic 

Sizing handles 

Picture Tools Format tab 

Presenter
Presentation Notes
A graphic object is sized and moved just like a placeholder. 

To change the graphic size, drag a corner placeholder, to maintain the aspect ratio.
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Adding Graphic Effects 

Graphic effects 
applied 

Original Graphic 

Picture Tools Format tab 

Changes the color 
of clip art images 

Open Picture Styles 
gallery 

Presenter
Presentation Notes
The addition of a customized graphic image gives your presentation a more polished look.

The Live Preview feature shows how the selected graphic will look with the selected picture style.
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• Displays the slides in 
full screen and in 
order 

• Plan what you will say 
while each slide is 
displayed 

 

REHEARSING 
A PRESENTATION 

Moving Between Slides 

 

Presenter
Presentation Notes
View your presentation on your computer screen as a slide show. A slide show displays each slide full screen and in order. While the slide show is running during this rehearsal, you can plan what you will say while each slide is displayed.

When you view a slide show, each slide fills the screen, hiding the PowerPoint application window, so you can view the slides as your audience would. You will begin the slide show starting with the first slide.

After the last slide is displayed, the program returns to the view you were last using, in this case, Normal view.
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• Displays 
properties 
– Filename 
– File size 
– Dates 

• Specify properties 
– Author 
– Tags 

 

DOCUMENTING A FILE 

 

Presenter
Presentation Notes
Open the File tab and choose Info.
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• Printing a Slide 
• Printing 

Handouts 
• Printing an 

Outline 

PREVIEWING & PRINTING 
THE PRESENTATION 
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Printing a Slide 
Preview shows how 
the slide will appear 

when printed 

Next Page button 

Print options 

Previous Page button 

Changes which 
slides print 

Presenter
Presentation Notes
PowerPoint displays a preview of how your printed output will appear as you specify the print settings. This allows you to make changes to the print settings before printing and reduces unnecessary paper waste.

The preview area displays the first slide in the presentation as it will appear when printed using the current settings. It appears in color if your selected printer is a color printer; otherwise, it appears in grayscale (shades of gray).

Open the File tab and choose Print.

To print a single slide, choose Print Current Slide in the Settings area.
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Printing Handouts 
Print options 

Preview area shows 
the handouts as they 

will print. 

Page scroll box 

Specifies type 
of output 

Full Page Slides 
Notes Pages 
Outline 
Handouts 

Output Types 

Presenter
Presentation Notes
You also can change the type of printed output from full page slides to any one
of the output settings described in the table below. Only one type of output can
be printed at a time.

Output Type 	Description
Full Page Slides 	Prints one slide on a page.
Notes Pages 		Prints the slide and the associated notes on a page.
Outline 		Prints the slide content as it appears in Outline view.
Handouts 		Prints multiple slides on a page.
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Choose a method for exiting 
PowerPoint 

1. Click Close (   ) in the title bar 
2. Select            from the File menu 

EXITING POWERPOINT 

Don’t forget to save 
your work before 
exiting PowerPoint. 

Additional Information 

 

Presenter
Presentation Notes
Don’t forget to save your work before exiting.
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Key Terms 
• AutoCorrect 
• character formatting 
• clip art  
• current slide 
• custom dictionary 
• default settings 
• demote 
• drawing object 
• embedded object 

 

• graphic 
• keyword 
• layout 
• main dictionary 
• Notes pane 
• object 
• Outline tab 
• paragraph formatting 
• picture 
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Key Terms 
• picture style 
• placeholder 
• placeholder text 
• promote 
• sans serif font 
• serif font 
• sizing handles 
• slide 
• Slide indicator 

 

• Slide pane 
• slide show 
• Slides tab 
• source program 
• spelling checker 
• style 
• text effects 
• thumbnail 
• view 
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FAQs 

1. What is a slide? 
2. What errors will AutoCorrect fix? 
3. I need to view all of my slides so that I 

can rearrange the order. How can I do 
this? 

4. I need to rearrange the slides in my 
presentation. How can I do this? 

5. What is meant by demoting and 
promoting bulleted items?  
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FAQs 

6. What are placeholders? 
7. My slide seems too crowded. Is there a 

way to split text between slides? 
8. What is the file extension for a 

PowerPoint presentation? 
9. What are slide layouts? 
10. I would like to use graphics in my 

presentation. Where can I find them? 
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Discussion Questions 

1. Discuss various slide layouts. How do you know 
which layouts are most appropriate for your 
content? 

2. PowerPoint offers a number of ways to view 
slides. Discuss when you would use Normal 
view, Slide Sorter view, and Slide Show view. 
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Discussion Questions 

3. Discuss the difference between the 
main dictionary and the custom 
dictionary. 

4. Discuss the AutoFit feature. How 
does the Split Text option work? 

5. What is the difference between 
character formatting and paragraph 
formatting? 
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